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General Information 

The UniVert is a precision test instrument designed for the compressive and tensile testing and 
analysis of materials including polymers, biological specimens, and 3D-printed constructs. The 
UniVert system includes a test station and an integrated software interface to run and analyze 
test results. 

Environmental and Electrical Specifications 

Electrical Input 24 VDC 

Current Rating 2.71 Amp 

Environmental 
Conditions 

Maximum Operating Temperature 
25ºC 

0% - 95% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree 2 

Data Connections 1 – USB for camera/PC 
communication 

(USB 3.0 for scientific camera) 

1 – USB for controller/PC 
communication 

System Assembly 

Some basic assembly and setup is required. An unboxing and setup guide can be found in 
Appendix A.  Load cell installation is detailed in Appendix B and software installation is 
described in Appendix C. Test setup and configurations are described in Appendix D. Camera 
setup is described in Appendix E. 

Connections to Supply 

Connect the power supply into a properly grounded 100-240VAC power source to ensure safe 
operation. Ensure that the power cord is easily accessible at all times. The use of an 
Uninterruptible Power Supply (UPS) is recommended to protect against data loss. 

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage. 
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Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual. 
Operators of this equipment must be instructed in safe operating procedures to prevent injury 
and/or damage. 

 
Ensure that the area around the moving actuator is clear before commencing test protocols. 

 

 

 

The UniVert presents a pinch hazard to extremities. Keep hands clear of moving parts for the 
duration of the test. 

 

Manual Operating Controls 

There are 3 manual switches on the front of the baseplate. In order of left to right, the main power 
switch, the heated bath switch (optional add-on), and the E-Stop switch. The E-stop will stop 
power to the motor and instruct the software to stop a test if one has been executed. If the E-stop 
has been depressed, it must be rotated to return it back to its original position. 

The E-stop should only be used in emergency situations only since it will require a power cycle 
and actuator reset to set up a new test after it has been depressed (see Setting Up & Starting a 
Test: Step 8 for more details). 

  

System Alert 

This equipment must not be disassembled by the user or modified in any way except that 
which is described in this manual. 
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General Maintenance 

Clean the system as needed with mild detergent and water or alcohol based cleaning solutions.  

It is recommended to jog the actuator from end to end at least once a month to distribute the 
lubricant along the ball screw. This is especially crucial if the tests protocols only involve short 
displacements, as it could wear down that portion of the ball screw over time. 

 

 

To distribute the lubricant: 

1. Remove all fixtures from the UniVert (i.e. compression platen or tension grips) 
2. Using the Actuator Controls, click and hold the inward button to move the actuator 

downward until it reaches the bottom 
3. Click and hold the outward button to move the actuator towards the top. It should stop at 

the limit switch. 
 

 

Approvals and Certification 

This product conforms to applicable CE standards. 
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Testing Terminology 

The UniVert is designed to apply uniaxial compressive and tensile forces to a variety of materials. 
This includes soft metals, plastics, and composites as well as biological materials. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different 
degrees and at different rates. There are three main reasons for doing this: 

Preconditioning - Especially for biological specimens, the goal of preconditioning is to restore a 
specimen to its physiological or in vivo state. During the process of specimen storage and 
preparation, a specimen may swell, dry out, have its material fibers realign, or its molecules 
reorganize. It may take multiple preconditioning cycles for a specimen to be restored to its natural 
state. 

 

Reproducing Physiological Conditions During Testing - By applying various loads and load 
rates, natural expansion and contraction of a specimen can be reproduced (for example, the 
pulse pressure in an organ). In as much as the physiological conditions can be recreated, the 
specimen can be tested in a more realistic state. 

 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test profiles 
to best study your specimen. 
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Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is 
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal 
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test 
sequence is made up of multiple test sets.  

 

The above example describes the following: 

• The entire diagram presents a full test sequence.  

• Within that sequence, there are two test sets: the first set applies preconditioning to the 
specimen; the second set executes the actual test on the specimen.  

• Within the first set (preconditioning), two identical test cycles are implemented to bring 
the sample to a satisfactorily preconditioned state.  

• Finally, the second set (testing) is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are five phases within a cycle. 
Each phase serves a specific purpose:  

Preloading- Preloads are applied to bring a test to a well-
defined starting point. Because the dimensions of a 
specimen may change as a result of a loading cycle 
(stretching of fibers, viscoelastic effects, plastic 
deformation, or localized material failure at the attachment 
points), the preload adjustment compensates for any of 
these changes in specimen geometry.  

Stretching - During the stretch phase, a deformation is 
applied to the specimen. The deformation can be specified 
either in terms of force applied or displacement achieved. 
Note that in this context, the stretch phase refers to either 
stretching (for a tension test), or compression (for a 
compressive test). 

Holding - The deformation can be held for a given 
duration. The duration for which it is held is dependent on the nature of the testing. 

Recovering - The recovery phase is the time during which the force being applied to the 
specimen is removed. The duration of the recovery time is configurable and dependent on the 
nature of the testing. 

Resting - Finally, the rest phase is the time between the end of one cycle and the beginning of 
the next. Some tests may specify a short recover time or no recover time, while others may 
specify a longer time. The duration is configurable and dependent on the nature of the testing. 

Control Modes 

There are two control modes which define the basic approach to a given test: displacement 
control and force control: 

Under displacement control, the displacement of the specimen is predefined. The 
UniVert stretches or compresses the specimen until the predefined displacement is 
achieved (specified in mm or %). The force required to achieve the displacement is an 
output of the test. 

Under force control, the force applied to the specimen is predefined. The UniVert 
stretches or compresses the specimen until the predefined force is achieved (specified in 
newtons [N]).  The displacement required to achieve the force is an output of the test. 

In addition, strain control from image feedback is available for UniVert systems with scientific 
camera packages. This control mode utilizes displacements based on a region within a specimen 
rather than global actuator displacements. For more information on this control mode and how to 
set up a protocol with this mode, see the Strain Control from Image Tracking section below.  
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Control Functions 

The UniVert makes it possible to test specimens under several control functions: 

Under displacement control: 

The ramp function applies the displacement at a constant nominal rate. This is 
equivalent to engineering strain or constant velocity.  

The sinusoid function applies the displacement according to a sinusoid with the desired 
displacement magnitude and duration. The UniVert system approximates this with a 
series of linear segments. 

 
Under force control: 

The ramp function applies the force at a constant nominal rate. This is equivalent to 
engineering strain or constant velocity. The result of this test will depend on the material 
being tested and the force control settings.   

The sinusoid function applies the force according to a sinusoid with the desired force 
magnitude and duration.  

Test Modes and System Configurations 

There are three test modes that can be used when performing a test: tension, compression, and 
3-point bending. 

Tensile Test - This test mode is used in combination with provided specimen grips. In this mode, 
positive displacement is in the direction of increased fixture separation and tension forces are 
positive. 

Compression Test - This test mode is used in combination with provided compression platens. 
In this mode, positive displacement is in the direction of decreased fixture separation and 
compressive forces are positive. 

 

The UniVert can be used in two configurations: vertical and horizontal (see Appendix D for 
more details). The above test modes are all compatible in both configurations. For compression 
and 3-point bend testing, test samples will need to be supported to meet the height of the platens. 
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Software Overview 

The software included with the UniVert device is called UniVert.  It is divided into several 
modules: a data collection module and an image review and analysis module as well as test 
template review.  The data collection module is used to set test parameters, enable specimen 
loading and testing, and monitor test progress.  The screen layout for this module is shown 
below: 

 

The Data Analysis software is an additional program used to review and analyze data and images 
collected by the UniVert. For more details, see the included Data Analysis user manual in the 
Documentation folder (Cellscale>UniVert>Documentation). 
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Output Files and Data Structures 

For each test, the UniVert creates and saves three file types. The following table describes the 
three file types for a project named “Sample1”. Output from this test would be found in a 
“Sample1” output directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the 
test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such 
as time, force, and displacement values. 

.jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to 
an image captured at 10.3 seconds from the start of the test. 

 

Each test folder will also contain 2-3 subfolders.  The “Logs” subfolder contains a text file of the 
content of the text dialogue portion of the main screen (in the lower left-hand side).  It is useful as 
reference to troubleshoot problems with your system, should they occur as well as track test 
progress. 

The “Images” subfolder usually contains any recorded .jpg images from a test.  These may also be 
stored in the main data folder. 

Additional “Analysis” and “Tracking” folders will be created if the data file and/or images are 
reviewed and processed in the Data Analysis software module. These folders will store tracking 
information and other preference settings. For more information, see the Data Analysis user 
manual in the Documentation folder. 

When working with the data, the user should be aware of a few details regarding the data output: 

1. The output specimen size is based on the spacing between the grips or platens and does 
not account for the specimen material outside of the test region. 

2. The software cannot calculate stress since the thickness of the specimen is not known. 
To calculate stress, you will have to manually measure the thickness of the material 
before or after the test is performed and apply this measurement to the output force data 

3. Strains can be calculated using the output displacement values (which are based on the 
grip or platen motions). The specimen may actually be subjected to less strain than the 
calculated values due to attachment site effects. The image tracking module is useful for 
determining the actual strain values and variations within the specimen. 
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Setting Up & Starting a Test 

Overview 

Step 1: Start a New Test 

Step 2: Reset the Actuator 

Step 3: Specify Test Type 

Step 4: Zero the Load Cell (occasional) 

Step 5: Modify the Test Parameters (optional) 

Step 6: Mount the Specimen 

Step 7: Execute the Test 

Step 8: Terminate the Test Prematurely (optional) 

Step 9: Saving the Template (optional) 

Step 10: End of Test Controls (optional) 

If this is your first time setting up the UniVert system, please complete the steps in Appendix A: 
Unpacking and Initial Setup prior to executing a test. 

Step 1: Start a New Test 

Launch the UniVert software and then select Collect New from the File menu.  
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In the Create Test From Template dialog, perform the following steps: 

1. Select a template that matches the type of test you wish to perform. See the below 
UniVert Tip on how to select and use a template. You can modify the template 
parameters in Step 5 below.  

2. Name your test. The dialog will have a default test name. You can use the default or 
rename the test. Each time you start a new test, the default name will continue to 
increment the number at the end of the name (a 3 digit number). 

3. If desired, you can change the location of the output data. The location of your output 
data and images is determined by specifying a Test Name and Data Directory. The 
template and data directories are user specific (computer login name). Each system user 
can store their files to a different default location. The system uses the last location 
selected as the default.  Note that a local drive should always be used and data 
transferred to network or cloud location after a test is complete. 

 

 

Step 2: Reset the Actuator  

We suggest performing a reset at the start of a new test session. This command sends the 
actuator to its fully retracted position and resets the displacement value.  If you have stopped the 
previous test in mid cycle, then you should also reset the actuator. By resetting the actuator, you 
are ensuring that the displacement measurements taken by the UniVert are accurate (dependent 
on an accurate Zero Position Calibration – see System Calibration and Advanced Tools).  

If you need to recalibrate the UniVert position, see the Zero Position Calibration or Custom 
Position Calibration portion in the System Calibration and Advanced Tools section. This is 
recommended if you are changing fixtures or configurations. 

To reset the actuator, select Reset Actuator from the Tools menu, or press  on the toolbar. 

 

 

 

  

UniVert Tip: Selecting and Using Templates 

How to create a Template: Designing an appropriate test sequence depends on both the type 
of material being tested and the specific material properties you are interested in measuring. 
When first testing a new material, you will have to experiment with the settings until the test 
yields meaningful data.  

The system comes loaded with sample templates to help you get started. Selecting a template 
does not lock you into a specific test sequence or protocol – rather a template preloads a test 
sequence and settings, all of which can be changed before a test is run.  

Once you have developed a test sequence with settings that are appropriate for the material 
you are testing, you should save these settings using “Save As Template” from the File menu. 
You can then select this template the next time you initiate a test. 

System Alert 

You should NOT reset the actuator if the specimen is already loaded in tension. Doing so will 
damage your specimen and/or the load cell. 
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Step 3: Specify Test Type 

Access Test Mode in the Settings menu to select the appropriate test mode and install the 
platens, grips, or 3-point bend attachments (see Appendix D for this procedure). 
 
 

 
 

Step 4: Zero the Load Cell (occasionally) 

While it is not necessary to zero the load cell with every test sequence, we suggest zeroing the 
load cell at the start of a new test session. With repeated use, the zero point of the load cell can 
drift. By zeroing the load cell, you are ensuring that the force measurements are accurate.  The 
force offset can also be affected by changing the fixtures. 

To zero the load cell, select Zero Load Cell from the Tools menu or press  on the toolbar. 

 

 

 

 

  

System Alert 

You should zero the load cell after attaching a platen or grip but before mounting a sample. If 
a specimen is already loaded when the load cell is zeroed, the force reading will include an 
offset load. 
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Step 5: Modify Testing Parameters (optional) 

 

 

You can select and modify the parameters in the test sets by clicking on a row in the Test 
Sequence table and then pressing the Edit Set button (or by double clicking on the desired row). 
When you do so, the Set Parameter Editor dialog will appear.  

 

Note that displacements are specified in either % strain, or mm. Force loads are specified in N, 
and durations are specified in seconds. 

The following table describes each of the parameters: 
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Test Parameter Description 

Control Mode Tests are performed under displacement or force control, however, you 
can select the following control modes to achieve specific testing 
objectives: 

• For creep testing, use force control with a long hold duration. 

• For stress relaxation testing, use displacement control with a 
long hold duration. 

Control Function True Strain, Ramp, or Sinusoid is typically selected for tests performed 
in displacement control mode. For tests performed in force control 
mode, Ramp or Sinusoid controls are selected.  

Stretch Magnitude  
(Load Magnitude 
when in Force 
Control mode) 

Selecting a stretch magnitude is dependent on the material you are 
testing. A sound approach is to begin with a small magnitude and 
iteratively move up to larger magnitudes.  

If you are using Displacement control mode, you can specify the 
displacement in either mm or as a percentage. For example, the 
displacement on a 5mm specimen can be expressed as either 0.5mm 
or 10%. 

If you are using Force control mode, you can only specify the force in 
N. 

Watch the test results carefully to determine which magnitude setting 
best achieves your test goals. 

Preload Preload is typically reapplied on every repetition during a 
preconditioning set as well as on the first repetition of a testing set. 
Specimen size is adjusted after a preload adjustment. Strain 
calculations are based on the specimen size after the last preload 
adjustment.  If you are working with a material for which preload values 
have been suggested, you can set the value accordingly. Otherwise, 
zero is a good initial choice.  The preload accuracy is directly influenced 
by the resolution/accuracy of the load cell you are using. 

Preload Magnitude As with stretch magnitude, the preload magnitude settings depend on 
the material you are testing. While Preload can be set at zero, typically 
you would set the preload magnitude somewhere between zero and 
10% of the peak load you expect to achieve. 

Stretch Duration For evenly spaced images, it is recommended to choose a number that 
is an integer multiple of the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or 
relaxation testing. 

Recovery Duration Recovery Duration is typically set to the same value as the Stretch 
Duration. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be 
used to mimic in vivo conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one 
repetition to the next start to overlie each other. 

Data Output 
Frequency 

Typically set to the same frequency as the image output frequency. 

Image Output 
Frequency 

Typically set to 1Hz for cycles > 5 seconds and 15 Hz for cycles < 5 
seconds. 
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Step 6: Mounting a Specimen 

Platen Mounted Specimens 

1. Install the compression platens (see Appendix D for more details) 
2. Place the specimen on the bottom platen.  
3. Jog the top platen to the correct position using the jog arrows in Actuator Control 

 

 

Alternatively, the Move Actuator to Specified Size  command may be used. Ensure the correct 

size value is entered before clicking .   
 

 
 

 

 

 

UniVert Tip: Compression Specimen Mounting 

Make sure to center the specimen on the platen as much as possible to ensure accuracy in 
the force reading. Ideally, specimens will have two parallel flat sides and will make full contact 
with both platens. Although this is not always possible, flat testing surfaces will improve force 
distribution. 
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Grip Mounted Specimens 

Low Force Grips 

1. Select a spring with an appropriate clamping force for the specimen being tested (see 
Appendix G for more details). 

2. Jog the actuator using Actuator Control until the grips are sufficiently far apart or enter the 

desired size and select Move to Specified Size . 

 

3. Attach the specimen to the top grip.  

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and lower the specimen between the grip surfaces.  Release the 
bottom grip. 

 

 

 

 

  

UniVert Tip: Specimen Thickness 

Measuring the specimen thickness before and/or after a test is performed will allow stress 
calculations to be made from your output data. 
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High Force Grips 

1. Select a spring with an appropriate clamping force for the specimen being tested (see 
Appendix G for more details). 

2. Jog the actuator using Actuator Control or select Move to Specified Size  until the grips 
are sufficiently far apart.  

3. Loosen the M4 screw with a 3 mm hex key and squeeze the two halves of the top grip to 
clamp the sample. For higher clamping force, use the same hex key to tighten the locking 
screw against the back face of the grip. 

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and clamp the specimen between the grip faces. Use the 3 mm hex 
key to tighten the locking screw if higher clamping forces are required. 
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3-Point Bend Specimens 

1. Choose the appropriate 3-Point Bend dowel for the type of test you wish to perform. 
2. Install the 3-Point Bending test setup (See Appendix D) 
3. Move the sliders into desired position and lock in place by tightening the 4-40 fastener to 

the rail using a 3/32” hex key. 
4. Place the specimen on top of both lower dowels and begin testing. 

 

 
 
 

 
 
  

System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while handling a 
load cell: 

• The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating may cause permanent damage to the 
load cell. 

• Avoid applying excessive torque and transverse forces to the load cells. Over 
tightening grips or platens onto the active end of the load cell may damage it. 

• Accidentally crashing the platens or grips together will produce more force than most 
load cells can handle. Be careful and reduce actuator speed when jogging grips or 
platens close together. 

• Generally, avoid dropping, tapping, and exerting unnecessary force to increase the 
life of the load cell 
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Step 7: Execute the Test 

Select Execute from the File menu or press  on the toolbar. 

Step 8: Terminate the Test Prematurely (optional) 

You can stop a test at any time by clicking  on the toolbar, or by selecting Stop from the File 
menu. These are preferred methods of ending a test instead of powering down the equipment or 
using the E-Stop, as it allows the software to store the current actuator position. 

At the end of the completed test (both normally and prematurely terminated) the actuators will 
maintain their current position.  

In an emergency, the Emergency Stop (E-Stop) button can be pressed to stop the motor from 

moving.  This button will stop power to the UniVert acutator and allow it to be moved by 
hand. The displacement position cannot be stored if the E-Stop has been depressed.  

 

Once the UniVert is ready to be used again, twist the E-Stop to return it to its original position. A 
new test cannot begin until the E-Stop has returned to its original position. The actuator will need 
to be reset to restore the position. To reset the actuator, select Reset Actuator from the Tools 

menu, or press  on the toolbar. An actuator reset is required before beginning a new test. 
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Step 9: Saving the Template (optional) 

At the end of the test (or before beginning the test), you may save the test parameters entered as 
a new template. Select Save as Template from the File menu. The Save Test as Template 
window will appear. Set a template name and click Save.  

 

By default, the new template will be stored in the current template directory. You may change the 
template directory at the start of a new test in the Create Test from Template window.  

 

 

 

If you would like to set a new template directory, create a new folder in your Windows File 
Explorer and set this file path as the new directory in the Create Test from Template window. You 
may delete templates through the File Explorer. Moving templates between directories will need 
to be done through the Windows File Explorer. 
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Step 10: End of Test Controls (optional) 

Once the test has been completed, you can choose to start a new test or use the system controls 
by selecting the “OK” button.  

 

 

System controls include the top ribbon as well as Actuator Control. These controls can be useful 
if you need to release a specimen from the text fixtures at the end of a test. 
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Strain Control from Image Tracking 

Strain control from image tracking is an alternate test control mode that can specify and control 
the test displacements based on a region within a specimen rather than the global actuator 
displacements.  When deforming a specimen, strain values often vary near the attachment sites 
compared to the middle region of a specimen.  This is especially evident when using BioRakes 
which tend to deform more around the rake tine puncture points compared to other parts of the 
specimen.  Clamped specimens usually have lower strains around the clamps because the 
clamps prevent lateral deformations.   

Controlling the applied strain in a region of a specimen is achieved by tracking image features in 
real time during test execution. 

When a template with Strain Control from Image Tracking protocols is opened, the pop-up 
window shown below will appear to indicate so. 

 

 

 

Specify Testing Parameters 

To use strain control:   

1. Double click or select Edit on the 
desired protocol line to open Set 
Parameter Editor 

2. Select Strain From Image as the 
Control Mode. This mode will only 
be available if a scientific camera 
set up is connected.   

3. Select Sinusoid or Ramp control 
function. 

4. Magnitude is in % and is calculated 
as the change in length divided by 
the initial length at the start of the 
stretch phase. The initial length is 
updated after preloads. 
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System Alert: Preload with Strain from Images 

When using preloads with the strain from images control mode, the force control 
velocity parameter must be set to a value of 4 or lower. Higher velocity settings may 
result in failure to execute the preload due to the image tracking algorithm speeds. 

If the force control velocity setting is greater than 4, it will automatically be reduced to 4 
upon executing the test to ensure successful completion of the preloads and test 
protocol.  

 

 

 

Selecting the Tracking Point Locations 

A test protocol that is using strain control with image tracking will display a rectangle in the live 
video feed as follows: 

 

The small squares are the points that will be tracked.  The location of the tracking points can be 
adjusted by clicking and dragging the corners of the box or the center tracking points on each 
side.  

The average distance between all pairs of points is used for strain calculations.  Tracking is 
performed using a digital image cross-correlation technique with updates at 20 Hz. For strain 
control using image tracking to be successful, there must be sufficient texture patterns or fiducial 
markers present in the images.  Texture patterns can be added to specimens with marking pens 
or a light dusting of graphite or other contrasting powders on the specimen. 

The colour of the tracking box and points can be adjusted in the Strain Control from Image 
Tracking Settings (see below). 
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System Alert: Selecting Correct Camera Orientation 

Arrows must match primary axis motion direction. Arrows are determined by the camera 
orientation. The camera can be manually mounted in different orientations and must be 
correctly specified in the camera settings dialog. This can be done by selecting the 
Camera tab in the Hardware menu (under Settings in the ribbon menu). 

 

 

 

Configuring the Live Charting Graphs 

The strains can be displayed on the live charting graphs when using the strain control from image 
tracking feature. The graphs can display measured strain or nominal strain. 

• Measured Strain is the calculated strain from the image tracking. 

• Nominal Strain is calculated from the motion of the actuators. 

The graph settings can be specified by selecting Graphs from the Settings menu. 
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Configuring Output Data Files 

Measured and Nominal strains 
are available as test output 
columns for the csv data file. 
From the Settings menu, select 
Data Output.  Then click the 
Configure button to select the 
desired output columns. 

 

 

Strain Control from Image Tracking Settings 

To access the settings for Strain Control from Image Tracking, select Settings in the top ribbon 
and Strain from Image. The colour of the tracking points can be modified as well as 
disabling/enabling the pop-up window at the beginning of each test. 
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Executing the Test 

Upon executing a test, the dialog box shown below will appear.  It gives options to automatically 
adjust camera settings and to automatically adjust tracking point locations.  Optimized lighting 
and camera settings and adjusted tracking points locations may improve the success of tracking.  

Click proceed with Test to execute the test. If the software is unable to continuously track a point, 
the test will automatically stop to prevent any damage to the system. If this occurs, more textured 
patterns or unique features may be required to generate better tracking points for the software to 
follow. 
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Advanced Controls 

Strain control from image tracking 
is controlled with a PID control 
algorithm.  The PID control 
parameters can be adjusted by 
selecting Motion Control from the 
Settings menu in the top ribbon. 

 

Check the Edit Advanced Settings 
check box then select Strain from 
Image in the control mode drop 
down menu.  

 

Increase the Kp value if the 
system is not responsive enough 
or cannot achieve the specified 
strains. 

 

Decrease the Kp value if the 
system is producing unstable or 
oscillating results. 

  

The hardware defaults should 
work under most conditions and 
can be restored with the Reset to 
Hardware Defaults button. 
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 Additional Settings 

Configuring Output Data Files 

From the Settings menu, select Data Output to display the dialogue shown on the left. Click the 
Configure button to select which of the following columns to output. 

  

 

Output Column Description 

Set Name  User defined name of each set 

Cycle Cycle and Phase information 

Time (S) Time point in seconds a data point was recorded 

Size (mm) Specimen Gauge Length at any given time 

Force (N) Load Cell reading 

Displacement (mm) Reports the change in size relative to the initial size 

Compensation (mm) Reports overall compensation due to system stiffness (see the System 
Calibration and Advanced Tools section). Set to Off by default. 

Temperature (C) Temperature readings of the media bath from the probe (if applicable) 
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Advanced Settings 

Advanced Settings are available by selecting Advanced from the Settings menu. All these 
settings are specific to the test template selected unless otherwise noted. 

 

 

 

Show Warnings 

By selecting the check boxes, a warning dialogue will appear before either action button (i.e. 
Reset Actuators or Zero Load Cells). 

Resetting the actuators with a sample attached may damage the specimen, fixtures, and/or load 
cells.  To avoid resetting the actuators with a sample attached, a warning dialogue will appear 
after “Reset Actuators” is selected, prompting the user to proceed.   

System Stiffness Compensation 

System Stiffness Compensation can be used to compensate displacement readings that occur in 
the UniVert system during testing typically at high loads with low displacements.  Under most 
loading conditions these displacements are negligible and system stiffness compensation is not 
required.  

If you find this is necessary for your testing, check the enable button and see the System 
Stiffness Compensation section under System Calibration and Advanced Tools for more details 
and steps on how to complete the calibration procedure. 
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Advanced 

Checking the “Enable non-standard Image Output Frequencies” will enable Image Output 
Frequencies options between 1 and 20 in the Parameter Editor. It is important to note, the 
scientific camera will not be running at those frame rates natively. The camera will operate at its 
highest frame rate (45 fps) and the nearest frame to the selected frequency interval will be 
selected. This could result in an output image frame that does not exactly match the desired 
frequency output. This setting can be saved to a template. 

Checking the Enable Hardware Diagnostics will enable an LED light on the main controller circuit 
board to flash continuously. By default, the LED is not enabled as it can cause discernable noise 
on load cell signal communications within the circuit board. This checkbox should only be used 
for troubleshooting purposes only. This setting will not be saved to a template and must be 
checked for each test if required. 
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Motion Control Settings 

Motion Control Settings affect the rate and stability at which forces are achieved in force-
controlled procedures.  These settings apply to preloads as well as Force Control Modes. 
Changes to these settings are saved to the test template. 

 

Max. Velocity 

Maximum velocity setting can be set to an integer value between 1 and 10 (see chart below for 
corresponding velocity values). The velocity integer matches actuator jog speed on the UniVert 
software home screen. Typically for stiffer or smaller specimens (i.e. requires a short 
displacement to achieve desired force), use a lower velocity setting as this will allow for smoother 
force-controlled protocols. It may take a few trials to optimize your test protocols and settings for 
your experiment. 

Velocity Jog Integer mm/s 

1 0.039063 

2 0.078125 

3 0.15625 

4 0.3125 

5 0.625 

6 1.25 

7 2.5 

8 5 

9 10 

10 20 
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Acceleration 

Acceleration setting can be set as an integer value between 1 and 10 (see chart below for 
corresponding acceleration values). Changes made to the acceleration will affect tests under both 
force and displacement control.  Reducing this value may help smooth force-controlled tests 
under low loads or displacement-controlled tests at high speeds.  Tests run with lower 
accelerations will have softer transitions at direction or speed changes but may take longer than 
specified to achieve specified testing cycles. 
 

Acceleration 
value 

m/s/s 
Time (s) to 

achieve 20mm/s 
Travel (mm) to 

achieve 20mm/s 

1 0.002 10.000 100.0 

2 0.004 5.000 50.0 

3 0.008 2.500 25.0 

4 0.016 1.250 12.5 

5 0.032 0.625 6.3 

6 0.064 0.313 3.1 

7 0.128 0.156 1.6 

8 0.256 0.078 0.8 

9 0.512 0.039 0.4 

10 1.024 0.020 0.2 
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Inertial Force Effects 

At higher accelerations or when using heavier fixtures (relative to load cell capacity), inertial 
forces become more prominent and can impact force readings in test results. The table below 
outlines the inertial forces (mN) as a function of the corresponding fixture weight and acceleration 
selected. 

Accel 

# 

Accel 

(m/s/s) 

UniVert S/S2 Fixture Weight (g) 

A B C D E F 

8 6 17 50 93 160 

1 0.002 0.0 0.0 0.0 0.1 0.2 0.3 

2 0.004 0.0 0.0 0.1 0.2 0.4 0.6 

3 0.008 0.1 0.0 0.1 0.4 0.7 1.3 

4 0.016 0.1 0.1 0.3 0.8 1.5 2.6 

5 0.032 0.3 0.2 0.5 1.6 3.0 5.1 

6 0.064 0.5 0.4 1.1 3.2 6.0 10.2 

7 0.128 1.0 0.8 2.2 6.4 11.9 20.5 

8 0.256 2.0 1.5 4.4 12.8 23.8 41.0 

9 0.512 4.1 3.1 8.7 25.6 47.6 81.9 

10 1.024 8.2 6.1 17.4 51.2 95.2 163.8 

 

Fixture Fixture Name Material 
Compatible 
Load Cell 
Capacity 

A Low Force Compression Platen  Plastic 0.5 – 4.5N 

B Low Force Tension Grip Plastic 0.5 – 4.5N 

C Medium Force Compression Platen Plastic 10 – 20N 

D Medium Force Tension Grip Plastic 10 – 20N 

E Medium Force Compression Platen Stainless Steel 50 – 200N 

F Medium Force Tension Grip Stainless Steel 50 – 200N 

 

Note the fixture weights in the table above are approximate. You may calculate inertial forces for 
your own fixtures (included or custom) using Newton’s second law of motion, F = m*a, where: 

• F is the inertial force in mN 

• m is the fixture weight (mass) in grams 

• a is the acceleration selected in m/s/s (see acceleration table for reference) 
 

The inertial forces listed above are for linear ramp control with the UniVert in vertical orientation. 
When using the UniVert in horizontal orientation, inertial forces can be more evident due to 
vibrations/resonance as a result from the cantilevered fixtures off the load cells. Changing the test 
protocol to use sinusoidal control can help mitigate inertial forces as it reduces accelerations 
between direction changes of the actuator (e.g. when the test protocol changes from stretch to 
recover).  
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Control Algorithm Settings Editing (Advanced) 

This setting offers the option to change from the programmed adaptive control algorithm to a 
custom algorithm. We recommend using the adaptive algorithm that has already been optimized 
for the device, as improperly tuned PID settings may result in unstable behavior. We suggest only 
advanced users with specialized tests modify these PID settings. Contact CellScale for more 
information regarding these settings. 

For adaptive control, an initial gain value (K0) can be modified. This value must be greater than 
zero, and it is set to 1 by default. The force control may undershoot or overshoot its target when 
testing very soft or stiff specimens, respectively. The K0 value can be reduced to adjust for 
overshooting and increased to adjust for undershoot. 

 

 

UniVert Tip: Testing Force Control Settings 

It is important to have appropriate Force Control Settings that match the materials you are 
testing.   

To safely test Force Control Settings:  press  on 
the tool bar, or from the Tools menu select Move 
Actuators to Specified Load.  The dialogue shown on 
the right will appear.  The UniVert will attempt to 
achieve the specified load (force) but will stop when 
the specified load is reached, the actuator has 
displaced by the maximum specified amount, or the 
timeout time has elapsed. 

If the actuator oscillates around the specified loads 
but never achieves them try decreasing the velocity. 

 

If the actuator reaches the specified load too slowly, 
try increasing the velocity. 
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Range Limits 

Range limits can be accessed by selecting Range Limits from the Settings menu.   

 

 
 

Soft Range Limits 

To avoid collisions or sample destruction, it is useful to assign reasonable travel limits to the 
actuators. This is especially important during force control or preloading, where if specified loads 
cannot be reached, the actuators will keep moving until they reach the soft limits. 

• Min and Max Displacement, in mm, set the minimum and maximum positions to which 
the grips or platens can move.  These settings require adjustment especially when the 
fixtures are changed. 

• Max Force, in N, sets the maximum value of force at which a test will be automatically 
stopped.  The default value is set to the capacity of the load cells.  Setting this value may 
be useful to prevent sample destruction or overloading of the load cells. 
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Configuring the Live Charting Graphs 

The three graphs on the right side of the screen provide real-time user feedback during a test. 
These graphs are intended to be used for qualitative feedback, not for detailed analysis.  

The graphs are updated at a maximum frequency of 10Hz; certain short-duration tests may not 
show all the details that is present.  

The graph settings can be specified by selecting Graphs from the Settings menu. Auto scaling 
allows the axis min and max to start at the specified values but expand if the data values are 
larger or smaller than the initial limits. 
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Graph Data 

Force versus Time 

This graph shows how the measured forces 
are changing with time. Peak loads per cycle 
and force relaxation are all easily seen in this 
type of graph. Force is proportional to 
nominal (engineering) stress. 

 

Displacement versus Time 

This graph shows how the grips or platens 
are moving with time. The phases of the test 
sequence and size adjustments due to 
preloading are readily apparent in this type of 
graph. 

 

Force versus Displacement 

This graph displays a qualitative 
representation of the material behavior. 
Viscoelastic effects (like hysteresis) and 
material response to different loading phases 
are apparent in this graph. This graph is 
proportional to a nominal (engineering) 
stress-strain graph. 
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Sign Convention 

This setting is used to set the direction and force reading values for the test. For the UniVert 
device, Pull + refers to a Tension test and Push + refers to a Compression test. For example, If 
pull + is set for a tension test, the displacement parameters will result in the actuator to move 
upwards in order to stretch the specimen. 

For more details on which sign convention to select, see Appendix D: Test Setup. 
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Specimen Failure Detection 

The Specimen Failure Detection setting will automatically stop a test if the specimen has failed 
(e.g. torn, crushed, broken). This prevents the UniVert system from continuing to execute the 
remainder of the protocol if the specimen has failed.  

First, select the axis which a failure will be detected. The force readings from this axis will 
determine when a failure has been detected. Additional axes will be available if you have UniVert 
Plus model equipped with an auxiliary axis (e.g. Torsion, Inflation, or Shear). 

Next, enter a percentage by which the force must drop to for specimen failure to be detected and 
stop the test.  

The following 3 criteria must be met for a specimen failure to be detected: 

1. The force reading drops by at least the determined amount. This is relative to the 
maximum force reading during the current phase. For example, if failure detection is set 
to 50% and the maximum force reading is 20N, the test will stop when the force drops to 
10N. The value considered as the maximum force reading is reset after each phase. 
 

2. The displacement is increasing. This is relative to the sign convention (i.e. test mode) 
selected. Generally, the displacement increases during deformation phase (i.e. stretch or 
compress). For example, in a Pull+ (Tension) test, an increasing displacement occurs 
during the stretch phase when the actuator is moving away from the baseplate. 

 
3. The force reading must be greater than 1% of the load cell’s capacity. This is to 

prevent a failure detection from occurring due to noise on the load cell signal connection. 
It is possible specimen failure is not detected if the force readings of the test are very low 
relative the to the load cell’s maximum capacity. Adjust the force drop percentage 
accordingly and use a lower capacity load cell if necessary. 
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Reviewing Test Results 

The UniVert includes an additional software, Data Analysis, to review and analyze data collected 

from the device. This includes graphing, curve fitting, material modeling and image processing to 

determine detailed strain maps. Image analysis functionality is only available to UniVert systems 

equipped with the Scientific Camera package (see Appendix E: Camera Setup for more details).  

To open the Data Analysis program, select File>Analyze and Review Images from the UniVert 

software home page. More details about Data Analysis can be found in its user manual located in 

the Documentation folder (Cellscale>UniVert>Documentation). 
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System Hardware Settings 

Controller 

The UniVert uses an integrated control board rather 
than a group of PC controlled device drivers.  This 
minimizes communication lag and allows the device 
to operate asynchronously with the PC. The control 
board details can be seen by selecting Hardware 
from the Settings menu, which brings up the window 
shown to the right.  

 

 

 

 

Camera 

The UniVert software can be equipped with the standard webcam package, the scientific camera 
package, or no camera at all. The software will automatically detect which camera configuration is 
in use. 

Webcam  

The basic UniVert system comes with a Logitech HD 
1080p webcam intended to be used for recording 
images for image playback and review. This camera 
and software associated with it does not support 
image tracking. 

For image review purposes the webcam will capture 
images at up to 5 frames per second and obtain a 
resolution of 1900 pixels by 1080 pixels. Images 
captured by the webcam are written to a buffer. The 
test controller extracts images from this buffer at the 
specified frequency specified in the Set Parameter 
Editor (5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001 Hz) These 
images are written to the output directory. The file name is the ideal capture time. The actual 
capture time may differ from the ideal capture time by as much as 1/30 of a second since the 
images are extracted from a buffer. 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The webcam can be focused using the focus control in the Camera tab under Hardware in the 
Settings menu. The focal distance is set by entering a value between 0-100 (The higher the 
value, the smaller the focal distance). 

The shutter and gain control on the webcam are controlled automatically.  
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Scientific Camera Package 

The advanced scientific camera package is not included with the base UniVert system and is 
available as an added feature. This advanced option provides high quality images suitable for 
image tracking and the associated software is enabled with the image tracking feature (See the 
Reviewing Test Results section above or the Data Analysis software user manual). 

The camera uses a 2/3” CMOS image sensor to obtain a resolution of 2048 pixels by 2048 pixels. 
The camera shutter and gain can be controlled by accessing the Camera tab in Hardware 
Settings. 

The scientific camera captures images at 15 frames per second during every test and writes 
these images to a buffer. The test controller extracts images from this buffer at the frequency 
specified in the Set Parameter Editor (50Hz, 25Hz, 15Hz, 5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001Hz). 
These images are written to the output directory. The file name is the ideal capture time. The 
actual capture time may differ from the ideal capture time by as much as 1/30 of a second since 
the images are extracted from a buffer. 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The camera default shutter and gain are specific to each test template and can be set by 
selecting the Camera tab in Hardware from the Settings menu. The recommended maximum 
shutter speed is 10mS.  Typically, the camera iris is left fully open and the shutter and then the 
gain are adjusted to achieve the desired image brightness. 

Changing Camera Image Resolution – Only with Scientific Camera Package 

The default resolution of the camera is 2048x2048, the current image resolution is written at the 
bottom of the screen. 

 

 

If you would like to capture images at a higher frequency (25Hz or 50Hz) you can reduce this 
resolution to 1024x1024.  When you select the higher frequency, you will get the below prompt 
where you can reduce the image output frequency, Reduce Camera Resolution or for 25Hz you 
can leave it the same but note that images may be missed on long tests or if your computer 
cannot keep up. 
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Selecting “Reduce Image Output Frequency” will return you to the Set Editor, selecting “Reduce 
Camera Resolution” will bring you to the hardware settings window for the camera where you can 
change the resolution. 

To change this setting, you can access the camera settings from the Settings-> Hardware from 
the top menu 

 

Load Cell 

The load cells are semiconductor strain gauge based. 
They have accuracy equal to 0.2% of the rated full-
scale load. Load cells are available in 0.5N, 1N, 2.5N, 
4.5N 10N, 20N, 50N, 100N, and 200N sizes. Each load 
cell has a unique calibration factor which is stored in a 
chip contained in the load cell connector.  A calibration 
using test weights can also be carried out by the user. 

While the load cells should not have significant 
hysteresis or thermal drift, temperature changes or 
prolonged loading can introduce small offsets. It is 
recommended that the zero-load state be redefined 
before beginning a test. This can be done by selecting 
Zero Load Cells from the Tools menu or selecting 

 . 

The load cells are sampled at 100Hz, with hardware providing an 8-sample averaging to reduce 
noise in the data. Further sample averaging can be implemented by selecting Advanced from the 
Settings menu. 

Each load cell is calibrated and has a specific calibration factor which is stored on a chip in the 
load cell connector.  Field calibration using weights of known mass is possible (see the System 
Calibration and Advanced Tools section of this manual).  The range and calibration factor can 
be viewed by selecting Hardware from the Settings menu but are not editable in this menu. 

Warning: Permanent load cell damage can occur if 120% of the full scale value is exceeded. 
Handle the load cell with care and make sure to select appropriate test protocols to avoid 
overloading.  

Note: The Diagnotics button is only intended to be used for troubleshooting with CellScale’s 
Technical Support Team. If you suspect your load cell may be damaged, contact 
support@cellsacle.com.  

mailto:support@cellsacle.com
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Actuator and Motor 

The actuator is driven by a stepper motor under closed loop control. The motor moves a ball 
screw-driven carriage attached to the load cell and test fixtures. The actuator has a peak velocity 
of 20mm/s for the standard UniVert and 100mm/s for the UniVert S2 – High Performance. To 
prevent excessive velocities and accelerations, the control software will issue warnings if entries 
in the Set Parameter Editor result in accelerations or velocities that are out of range. Excessive 
thrust loads should only occur if mechanical interference obstructs the movement of the actuator. 
It is advisable to reset the actuators occasionally. The acceleration and velocity parameters can 
be modified in the Advanced Settings window if necessary for your materials or experiments (see 
the Advanced System Settings Dialogue section for more details). 

 

 

 

 

 

If the Emergency Stop (E-Stop) button has been depressed, power to the actuator will be cut. The 
motor carriage can be moved manually if necessary. However, the position of the motor will be 
compromised, and an actuator reset will be required before executing another test. 
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Heater 

To activate the fluid chamber heater, the unit must be 
powered on, and the heater cable must be connected 
(the computer and software do not need to be on yet). 
Turn on the heater toggle switch (below amber LED 
light), the heater will warm the fluid to the last used 
temperature set point. The temperature set point can 
be changed by selecting Hardware from the Settings 
menu.  

Typically, the heater will take 30 to 60 minutes to 
warm a full fluid chamber from room temperature to 
37°C and will take up to 90 minutes to stabilize at this 
temperature.  To reduce this time, it is encouraged to 
use pre-heated media. 

When Show Temperature Warnings is enabled and the Current Temperature is not at the 
Temperature Set Point plus or minus the specified tolerance -- a red indicator button will be 
displayed next to the Current Temperature live output and a warning dialogue will appear when 
you execute the test. 

The Control Settings (PID) section displays the programmed settings for the temperature control 
of the heated bath. These have already been optimized for the UniVert heated bath. This section 
only displays the setting values (i.e. cannot be edited) to ensure the correct values have been 
programmed. 

 

System Alert 

In the event of a dislodged or faulty temperature sensor, or if there is a lack of fluid in the fluid 
chamber, the system is designed to reach a maximum temperature of less than 80°C. 

 

 

Caution: Avoid touching the chamber’s metal back panel when the heater is on, it can 
become very hot! 

 

 

  

UniVert Tip: Preheat Fluid 

You can add preheated fluid to the fluid chamber to reduce warm up time. 
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System Calibration and Advanced Tools 

Load Cell Calibration 

The load cells are preset with a calibration factor during manufacturing and quality check. It is 
recommended to use this factory calibration.  However, calibration in the field is possible. When 
the load cells are set up for the first time, changed, or moved it is advisable to perform a load cell 
calibration check to ensure the factory calibration is still correct. This process will require a set of 
calibration weights (not included with system). Load cells can be calibrated attached to the 
UniVert system or with the Calibration Plates.  

If you are planning to overwrite the factory calibration value, we recommend using at least 3 
different weights spanning from 10%-90% of the full scale of the loadcell to ensure a correct 
calibration factor is found. 

Attached to System 

1. Attach the load cell to the fixed end of the UniVert (i.e. on the baseplate) with an M5x16 
SHCS and 4mm hex key. Ensure the measuring end of the load cell is facing away from 
the system (See Appendix B). 

 

 

 

2. Affix the calibration platen to the load cell. 

 

 



UniVert User Manual 

47 

 

 

3. Reset the actuator  to move the test fixtures out of the way. 

4. From the Tools menu select Load Cell Calibration 

 

 

 

5. Zero the load cell to remove the weight of the platen from the calibration values 
measured. 

6. Select the desired units to measure in. When using free weights this will always be in 
grams. 

7. Measure the zero-load condition for the first calibration point (no calibration weight) 

a. Enter “0” in the Enter Weight dialogue 

b. Click Read 
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8. Gently place a test weight onto the platen. This weight should be between 10%-90% of 
the load cell full scale value to ensure accurate calibration. Centre the weight on the load-
bearing surface to ensure in-line loads and use weights corresponding to the load cell 
capacity range. Do not overload the load cell. 

 

9. Take a measurement of the calibration test weight. 

c. Enter the weight in grams in the Enter Weight dialogue 

d. Click Read 

10. Repeat steps 8 and 9 with at least 2 additional weights covering most of the load cell 
range.  This will ensure a precise calibration factor is calculated. 
 

11. Click “Run”. 

12. Check the R Squared for reasonable values.  The R Squared is calculated based on a 
linear plot of the measured weights in the previous section. Ideally, this value should be 
as close to 1 as possible.  

13. Select which calibration factor to program to the load cell: 

a. Use Calculated Calibration will apply the new calculated value from the free 
weights applied in previous steps. This is recommended only if you are using 
NIST certified weights or using a Version 1 of the loadcell (6-position 
connector, shown below). 
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b. Use Factory Calibration will restore the factory calibration factor. For Version 2 
of the load cells (4-position connector and in-line box, shown below), we 
recommend using the factory calibration factor and using the test weights 
as a check. 

 

c. Continue with Current Calibration will keep the calibration factor that is currently 
programmed to the load cell. This could be the factory calibration factor if a new 
one has not been programmed. 

14. Click “Done” to close the window 

Note: Only take one reading per calibration weight used.  Multiple readings of a single load 
value can cause an error in the calibration algorithm  

Be sure to zero  the load cell again once the UniVert is in the desired testing 
configuration  

Calibration Plates 

Alternatively, the load cells can be calibrated detached from the UniVert fixtures. 

1. Carefully remove the load cell being calibrated if it is attached to the UniVert fixtures. 
However, ensure the cable is still connected to the UniVert. 

 
2. Attach the two provided calibration plates to both ends of the load cell. 
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3. Orient the setup such that the measuring end of the load cell is facing up and continue 
with the standard calibration procedure described above. 

 
 

 

 
Note: Calibration plates are only compatible with regular UniVert load cells. Low force load cells 
may only be calibrated while attached to the UniVert device. 
 

 

 

 

  

System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while handling a 
load cell: 

• The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating will cause permanent damage or failure. 

• Avoid applying torque and transverse forces to the load cells. Over tightening grips or 
platens onto the active end of the load cell may damage it. 

• Accidentally crashing the platens or grips together will produce more force than most 
load cells can handle. Be careful and reduce speed when jogging grips close 
together. 

Generally, avoid dropping, tapping and exerting unnecessary force to increase the life of the 
load cell. 
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Zero Position Calibration 

The actuator position is indicated in the Current Size dialogue on the left-hand side of the screen.  

 

This is the current separation of the edges of the clamps or platens.  For this measurement to 
have meaning, a zero position must be defined.  This is a position where the grip or platen tips 
would just touch each other.   

The Move to Size  command is also dependent on a correctly defined zero position. 

An actuator zero position is preset during manufacturing and quality check.  However, the zero 
position should be re-calibrated on initial system setup and whenever the grips, platens, load 
cells, or risers are changed.  Changing these components will always alter the zero position 
slightly. 

There is a software utility to automatically calibrate the zero position using a spring of known 
length provided with the UniVert system.  

The calibration spring is placed between the grips or platens.  The calibration utility slowly moves 
the grips or platens together until a small load is detected when contact with the spring occurs.  It 
then assigns this position as the size of the calibration spring being used. 
 
Note this calibration method should only be used for vertical configurations.  
For horizontal configurations, use the Custom Position Calibration outlined in the 
following section. Using Zero Position Calibration in the horizontal configuration could introduce 
off-axis loading on the load cell. This could result in inaccurate calibration or even damage to the 
load cell. 
 
To calibrate the zero position, follow these steps: 
 

1. Open the Zero Position Calibration utility by selecting Zero Position Calibration in the 
Tools menu. 
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2. Place the provided calibration spring on the bottom platen or grip.  
 

  

 

3. Zero the load cell using the Zero Load Cells button. 
 

4. Specify the spring length (mm).  This figure is provided for each spring included in the 
UniVert system. 

 

5. Using the jog buttons, move the actuator such that there is a small gap between the 
top of the spring and the bottom of the upper platen or grip.  Do not contact the top of 
the spring.  Using a slow jog speed (below 5) is advisable for this reason. 

 
6. Select Run and let the calibration utility proceed. The software will calibrate the zero 

position automatically. 
 

7. Press OK to Reset Actuators and complete the calibration. 
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Custom Position Calibration 

Alternatively, the UniVert position can be defined with the use of digital or vernier calipers. 

To set a custom position: 

1. Jog the fixtures so their distance is within the reading range of the calipers. 
 

2. Measure the distance between the fixtures with the calipers. Ensure the calipers are 
reading in millimeters.  

 

  

 

3. Open the Custom Position Calibration utility in the Tools menu 
 

 

 

4. Enter the distance read out by the calipers (in mm) and press Set to define a new custom 
position 
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System Stiffness Compensation 

System Stiffness Compensation can be used to compensate for the small displacements that 
occur in the system during testing due to flexion and load cell compression/tension. These 
displacements arise from any strains in the load cell and any bending or deformation of the 
system during loading. Under most loading conditions, these displacements are negligible and 
system stiffness compensation is not required.  System stiffness compensation plays a more 
significant role when testing stiff specimens that achieve high loads at low displacements.   

System Stiffness Compensation can be enabled or disabled under the Advanced Settings 
dialogue (Advanced from the Settings menu).  

Note: This calibration procedure is not required for UniVert systems with serial number UV55311 
or greater (purchased in Feb 2024 or later). Both the system and all load cells associated with the 
device have been factory calibrated. The factory calibrated compensation values can be enabled 
through the Advanced Settings window at your discretion. 

 

When enabled, output displacement 
and size data in the .csv data output 
file will be modified.  For example, in 
a test where a 10 mm specimen is 
being compressed by 1mm at 100N 
of force the system may be displaced 
by 0.1mm.  In this case when the 
actuators have moved 1 mm the 
specimen will only have been 
deformed by 0.9 mm and the other 
0.1 mm will have gone into deforming 
the load cell and system.  The output 
will show a displacement of 0.9 mm 
(rather than 1.0) and a specimen size 
of 9.1 mm (rather than 9 mm). 

 

Note: The system stiffness compensation does not affect or alter the applied loads or 
displacements only the reported values in the output .csv files. 

 

The amount of compensation being applied to the displacement and size columns of the output 
data file can also be shown as an additional output column (see the Additional Settings 
section). 
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If system stiffness compensation is enabled and factory calibrated values are not programmed, a 
calibration must be performed to determine the correct compensation factor.  This factor depends 
on the load cell being used and a new calibration must be completed each time the load cell is 
changed. There is a software utility to automatically perform this calibration. Before starting the 
software utility, attach the compression platens to the UniVert system. Also, place the Stiffness 
Compensation spacer that is provided (a small washer) onto the exact center of the lower platen.  

 

After placing the calibration spacer, slowly jog the platens together until there is a very small gap 
between the upper platen and the spacer. If this gap is too large, the software utility will take a 
very long time to run. However, do not allow the upper platen and the spacer to come in contact.  
If the platens crash together the load cell will likely be damaged.   

 

UniVert Tip: When to Apply System Stiffness Compensation 

Typically, System Stiffness Compensation will not be required.  It may be useful, however, 
when testing stiff specimens that achieve high loads at low displacements.  Most of the 
system deformation comes from the load cells which typically strain linearly by up to about 
200 µm at full scale load.  One can estimate the amount of system deformation by multiplying 
200 µm by the percent of load cell range that is used.  For example, when a load cell is at 
50% of its full-scale load (a 200N load cell at 100N, or a 10N load cell at 5N) the system 
deformation is estimated to be about 100 µm. To determine the effect of this displacement on 
your test you can divide this estimated system deformation by the maximum displacement in 
your test.   

For example, in a test with 10mm of displacement: 
100 𝑢𝑚

10 𝑚𝑚
=

0.1 𝑚𝑚

10 𝑚𝑚
= 1% 

We recommend using system stiffness compensation if the system deformation is more than 
10% of the applied deformation. 
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UniVert Tip: Jog Slowly to Protect Load Cells 

Jog the platens together at a slow speed to prevent crashing them together and damaging the 
load cell. Use lower jog speeds the closer the platens are to each other. 
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To perform system stiffness compensation calibration, follow these steps: 
 

1. Open the System Stiffness Compensation utility by selecting Advanced → System 
Compensation from the Tools menu.  

2. Zero the load cells.  
3. Use the jog buttons to decrease the gap above the spacer. Do not contact the top of the 

calibration spacer. 
4. Click Run to start the calibration and set the stiffness compensation value. 
5. Press OK to Reset Actuators and complete the calibration. 
6. The calculated system stiffness compensation value will be displayed in the message 

window. 
 

 

 

The calibration utility will slowly drive the platens together until the full-scale load is reached on 
the load cell.  Resulting load displacement data is typically very linear and a best-fit slope is used 
to determine the calibration factor.  Compensation is calculated in compression but is assumed to 
act linearly in both tension and compression. 
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Snap Image Feature 

Located under Tools>Snap Image. 

This feature allows the user to capture a single image during the setup phase.  This can be useful 
for documenting specimen loading activity and neutral (non-contact) beam position. 

 

Update Firmware 

Periodic firmware updates may be issued by CellScale for the UniVert. When a new firmware or 
software is available, you may download it from our website (www.cellscale.com/downloads).  

To update the firmware: 

1. Connect the UniVert to the PC via USB and turn on power to the UniVert 
2. Open the UpdateFirmware.exe program located in Univert>Software>Utilities>Update 

Firmware  
3. The program will automatically update the firmware of the UniVert 
4. Power cycle the system after the firmware is successfully updated before using the 

UniVert software again 
 

The firmware version is checked and the automatic updater is also run when installing a new 
version of the software. 

 

 
  

http://www.cellscale.com/downloads
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If the automatic firmware update software does not work, please follow the manual steps below: 

1. With the UniVert connected to the PC and turned on, launch the manual firmware update 
software located in UniVert>Utilities>Update Firmware>Advanced. 

2. Click the Connect button. 
3. Load the firmware file using the Browse button. The file will be a .bin extension. 
4. Execute the update using the Update button. 
5. Power cycle the system after the firmware is successfully updated before using the 

UniVert software again. 
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Troubleshooting 

Communication Errors: Read File or Write File 

When communication errors occur the live message window will display a ReadFile or WriteFile 
failed message. Communication errors can occur if: 

• The UniVert is not powered up. 

• USB cables between the computer and UniVert are disconnected. 

• The supply power surges or is interrupted.  

When a communication error occurs, close UniVert software, check connections, power cycle the 
UniVert Device, and restart the UniVert software.  Be sure to reset the actuators before setting up 
a new test. 

 

  

UniVert Tip: Preventing Power Disruptions 

We recommend plugging the UniVert (and host computer) into an uninterruptable power 
supply (UPS) or battery back-up. 
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Actuator Limits 

When changing between horizontal and vertical configurations, it is possible to reach the lower 
range limit of the actuator. Hitting the physical range limit may affect the accuracy of the Current 
Size reading. To avoid this, there are several software warnings which occur under these 
circumstances: 
 

Moving the actuator out of range with Move to Force :  
If the actuator is moved past the range limit when using Move to Force the UniVert software will 
display an error message (shown below). It is recommended to perform an actuator reset before 
continuing testing. You may need to adjust the range limits by selecting Range Limits in the 
Settings menu to accommodate your specimen.  
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Reaching the actuator limit during a test:  
If the actuator is moved past the range limit during a test, the UniVert software will terminate the 
test and display an error message: 
 

 
 

 

 
  

UniVert Tip: Zero Position Calibration 

Perform a zero position calibration (see the System Calibration and Advanced Tools 
section) when the load cell, grips, or risers are changed. A correct zero position will ensure 
that the failsafe features for the actuator limits (described above) will work as intended. 
 



UniVert User Manual 

63 

 

Emergency Stop  

 

If the Emergency Stop (E-Stop) has been depressed, a new test cannot begin until it has returned 
to the disengaged position. Twist the red E-Stop button on the UniVert controller in either 
direction and this will allow the switch to pop out again.  

 

 

 

This switch is intended to be used only in case of EMERGENCY as the actuator will lose its 
position when the E-Stop has been depressed. Once the E-Stop has been returned to its original 
position after the being activated, power cycle the UniVert and reset the actuators to restore the 
position accuracy. 

 

A test cannot begin until an actuator reset has been completed after the E-stop is returned to its 
original position. 
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Appendix A: Unpacking and Initial Setup 

The system components listed below may be unpacked and laid out before system setup. A 
clearance space (L x W x H) of 25cm x 35cm x 60cm and 60cm x 35cm x 25cm is required for 
vertical and horizontal configuration setup respectively. 

Tools 

Hex keys (2.5mm, 3mm, 4mm, and 5mm) 

Components 

Item Name Item Quantity 

UniVert Main Unit 

 

1 

Pivot Wings 

 

2 

Motor Bracket A* 

(Installed on device) 

 

1 

Motor Bracket B 

 

1 

Horizontal Bracket 

(No Load Cell) 

 

1 
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M5 Tension Load Cell 
Bracket 

 

1 

M3 Tension Load Cell 
Bracket 

 

1 

Load Cell 

 

1 

Calibration Plates 

 

2 

Light Grip Springs 

 

3 

Medium Grip Springs 

 

3 

Heavy Grip Springs 

 

3 

M3 Compression 
Platen (Plastic) 

 

1 
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M5 Compression 
Platen (Stainless Steel) 

 

1 

M5 Compression Base 
Riser - Tall 

 

1 

M5 Compression Base 
Riser – Short 

 

1 

M3 Specimen Grip 
(Plastic) 

 

1 

M5 Specimen Grips 
(Stainless Steel) 

 

2 

M5 Locking Discs 

 

2 

M3 Locking Discs 

 

2 
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M5 Coupling Nut 

 

1 

M5 to M3 Thumbnut 

 

1 

M5 Stand Off 

 

1 

Calibration Spring 

 

1 

Sample Test 
Specimens 

 

4 

Stiffness 
Compensation Spacer 

 

1 

Camera 

 

1 
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Tripod 

 

1 

24V Power Supply 

 

1 

USB Cable 

 

1 

Fasteners 

Size Purpose Quantity 

M4x12 SHCS Mount Pivot Wings to Main Unit 4 

M4x8 SHCS Attach Motor Bracket B to Motor Bracket A 4 

M5x12 SHCS 

 

Attach Horizontal Fixtures (M5) 

(see Appendix D for more details) 

Mount loadcell or fixtures to Motor Bracket B 

4 

M3x12 SHCS Attach Horizontal Fixtures (M3) 

(see Appendix D for more details) 

1 

M5x16 SHCS Mount fixtures to baseplate 1 

M4x25 FHCS To increase clamping force of M5 Specimen Grips 2 

 

 

  

SHCS 

(Socket Head Cap Screw) 

 

FHCS 

(Flat Head Cap Screw) 
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Initial Setup 

Step 1: Unpack the main unit and the accessories 

Set aside the main unit, Pivot Wings, 4 x M4x8 SHCS, Motor Bracket B, 4 x M4x8 SHCS, and 
3mm hex key 
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Step 2: Attach Motor Bracket B to Motor Bracket A 

Attach the Motor Bracket with 4 x M4x8 SHCS using the 3mm hex key 

 

 

Step 3: Attach the Pivot Wings to the main unit 

Attach both Pivot Wings to the side of the UniVert with 4 x M4x8 SHCS using a 3mm hex key 
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Step 4: Install the UniVert software 

See Appendix C: Software Installation for more information. 

 

Step 5: Attach the load cell 

See Appendix B: Load Cell Installation for this procedure. 

 

Step 6: Attach platens or grips to the load cell 

See Appendix D: Test Setup for this procedure 

 

Step 7: Connect all necessary cables to the UniVert 

A 24V brick power supply powers the UniVert system via a barrel connector on the back of the 
control box.  The UniVert control box is connected to the PC via a USB connection. 

The load cell connector has a keyway inside the connector and a locking ring to ensure proper 
connection. To connect a load cell, align the keyway, push the connector in, and turn the 
threaded locking ring until tight.  Note that this may require several turns to lock in place. 

The temperature probe and heater connectors also have a keyway. Align the red marks on both 
the panel connector and cable connector. These connectors will only be present if a Media Bath 
package is purchased with the UniVert (see Appendix F for more detail on how to set up the 
media bath). 

 

 

 

System Alert: Load Cell connector 

Only twist the silver threaded coupling when attaching and 
detaching the load cell connector. DO NOT twist the black 
rubber housing when the connector is mounted to the control 
box. This can damage the internal wiring and connectivity of 
the load cell.    

Load Cell 

Power 

USB 

Temperature 
probe and 

Heater 
(optional) 
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Step 8: Launch the software and begin a test to ensure the 
UniVert connects to the PC 

Run UniVert.exe and start a new test (File > Collect New). The software will output information on 
the initialization of the camera, load cell, and actuator. The software will output System Ready! 
when all systems have loaded and the UniVert is ready for testing. 

 

 

Step 9: Calibrate the Load Cell 

See the System Calibration and Advanced Tools section of this User’s Manual for more 
information. 

 

Step 10: Set the Actuator Zero Position 

See the System Calibration and Advanced Tools section of this User’s Manual for more 
information. 

 

Step 11: Begin Testing 

It is recommended that the User’s Manual be thoroughly reviewed before beginning testing using 
the UniVert system.  Procedures for loading samples, setting up tests, carrying out tests, and 
reviewing results are described in detail. 
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Auxiliary Axis 

UniVert Plus systems are equipped with additional connections for another test axis.  

 

Torsion Axis 

The Torsion test axis allows for rotational displacement and torque force measurements. For 
more information about the function and installation of the Torsion axis, please refer to the 
UniVert Torsion Axis User Manual located in the Documentation folder 
(C:\Cellscale\UniVert\Documentation). 

Inflation Axis 

The Inflation test axis allows for specimen inflation and pressure measurements. For more 
information about the function and installation of the Inflation axis, please refer to the UniVert 
Inflation Axis User Manual located in the Documentation folder 
(C:\Cellscale\UniVert\Documentation). 

Shear Axis 

The Shear test axis allows for lateral (perpendicular to primary axis) displacements and shear 
force measurements. For more information about the function and installation of the Shear axis, 
please refer to the UniVert Shear Axis User Manual located in the Documentation folder 
(C:\Cellscale\UniVert\Documentation). 
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Appendix B: Load Cell Installation 

In order to avoid load cell damage, proper installation is required. Follow these steps when 
installing for the first time or changing load cells: 

• If your load cells have a cylindrical body with a 6-pin connector, follow steps outlined in 
the Legacy Load Cell section. 

• If your load cells have a rectangular body with a 4-pin connector, follow steps outlined in 
the Current Load Cell section. 

Legacy Load Cell 

1. Identify the active end of the load cell (see below image). This is the MEASURING END 
of the load cell which results in a force reading. This end is covered with a small plate not 
continuous with the rest of the load cell body. 

 

 

 

2. Attach the appropriate thumbnut/coupling to the NON-MEASURING END of the load cell 
(M5 or M3 depending on the load cell). 
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3. Attach the load cell and thumbnut/coupling assembly to the UniVert device: 
 

• For vertical configuration attach the load cell to Motor Bracket B with an M5x12 
SHCS using a 4mm hex key 

• For horizontal configuration, mount it to the baseplate of the UniVert with an 
M5x16 SHCS using a 4mm hex key.  

 

 

  

 

4. The measuring end of the load cell should be exposed, and the non-measuring end 
attached to the thumbnut/coupling and then to the UniVert. The test fixtures are ready to 
be mounted to the load cell. 
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Current Load Cell 

1. Identify the active end of the load cell (see below image). This is the MEASURING END 
of the load cell which results in a force reading.  
 

 

 

2. Attach the appropriate thumbnut/coupling to the NON-MEASURING END of the load cell 
(M5 or M3 depending on the load cell). In the image below, the top load cell uses an M5 
screw, and thus requires the M5 coupling nut. The bottom load cell uses an M3 screw, 
and thus requires the M5 to M3 thumbnut. 
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3. Attach the load cell and thumbnut/coupling assembly to the UniVert device: 

• For vertical configuration attach the load cell to Motor Bracket B with an M5x12 
SHCS using a 4mm hex key 

• For horizontal configuration, mount it to the baseplate of the UniVert with an 
M5x16 SHCS in the horizontal mounting hole using a 4mm hex key. 

 

     

 

4. The measuring end of the load cell should be exposed, and the non-measuring end 
attached to the thumbnut/coupling and then to the UniVert. The test fixtures are ready to 
be mounted to the load cell. 
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Appendix C: Software Installation 

A Windows based PC (Windows 10 or above) with at least 1 USB ports is required to operate the 
UniVert (2 USB ports are required for the imaging feature).  Go to www.cellscale.com/downloads 
to download the latest UniVert software package. The package contains the software installer for 
the user interface and control software for the UniVert.   

To install the software: 

1. Go to the provided web address and download the compressed installation package.  
2. Transfer this file to the computer which will be running the UniVert device.   
3. After this is complete, go to the uncompressed installation folder and select UniVert 

Installer.exe.  Details of typical dialogue boxes are shown below. 
 

 

 

 

http://www.cellscale.com/downloads
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If your UniVert is detected this screen will popup: 

 

If UniVert is not detected, then you will be taken to a model selection screen where you can 
select your UniVert model. To install the correct user manual and templates please select the 
appropriate model. 
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UniVert User Manual 

81 
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Appendix D: Test Setup 

When using the UniVert in the vertical configuration, use the rightmost mounting hole on the 
baseplate for test fixtures. For the horizontal configuration, use the leftmost mounting hole on the 
baseplate for test fixtures.  

 

 

Tension Test Setup 

Set the test mode to Tension (Settings>Sign Convention>Pull +) in the software. This setting is 
specific to the test template being used and can be saved to a template. 

 

 
 

Horizontal 
Configuration 
Mounting Hole 

Vertical 
Configuration 
Mounting Hole 
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Vertical Configuration 

1. Install the desired load cell (see Appendix B) to Motor Bracket B. 
 

 

 

2. Screw a locking disc onto the measuring end of the load cell. Select either an M5 or M3 
locking disc based on the load cell. 
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3. Screw the appropriate grip onto the measuring end of the load cell after the locking disc.  
Tightening the locking disc against the grip allows the grip to be secured to the actuator 
at any rotational position. 

 
Finger tighten all components (ie. avoid using a wrench).  Beware of exerting excessive 
off-axis and torquing forces to avoid damage to the load cell. 

 

  
 

4. Attach the M5 stand off to the base with an M5x16 SHCS screw using a 4mm hex key. 
Use the mounting hole furthest from the power switch. This may be easier to do with the 
UniVert in the horizontal configuration. 
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5. Attached the M5 locking disc and grip to the stand off. 
 

 

 

6. Attach the remaining grp to the M5 Stand Off and align the two grips until they are 
parallel. Loosen the locking discs to adjust the grips. Once they are aligned, hold the 
grips in place while tightening the locking discs. 

 

 

 

7. A position calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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Horizontal Configuration 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

 

 

1. Install the load cell (see Appendix B) to the fixed end of the UniVert with an M5x16 
SHCS using a 4mm hex key. Use the mounting hole closest to the power switch. Note 
that for the horizontal configuration, an additional locking disc should be added between 
the load cell and thumbnut.  
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2. Install the grip to the Tension Load Cell Bracket 

• For an M5 threaded load cell, use the stainless steel M5 grip, M5 Tension Load 
Cell bracket, M5x12 SHCS, 4mm hex key and M5 Locking Disc.  

• For an M3 threaded load cell, use the plastic M3 grip, M3 Tension Load Cell 
Bracket, M3x12 SHCS, 2.5mm hex key, and M3 Locking Disc. 

 

 

 

 
3. Install the Tension Load Cell Bracket to the load cell and affix it with the corresponding 

locking disc. The size of both these fixtures (M5 or M3) will depend on the load cell 
selected. 
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4. Attach the moving grip to the Horizontal Bracket (No Load Cell) with an M5x12 SHCS 
using a 4mm hex key. 

 
 

 
 

 
5. Attach the assembly from the previous step to the Motor Bracket B with 2 x M5x12 SHCS 

using a 4mm hex key. 
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6. Align the grips until they are parallel by loosening the M5 screws and rotating the 

grip/assembly. When aligning the load cell/grip assembly, only handle the assembly by 
the body of the load cell. This is to prevent overloading or damaging the load cell. 

 

 
 

 
 

7. A position calibration is required after changing grips or platens. See the System 
Calibration and Advanced Tools section of this manual for more details. 

 

8. To prevent overloading and off-axis loading on the load cells, mount samples by pinch 
both the sides of the grip. Tilt the UniVert device away from you for more working room. 
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Compression Test Setup 

Set the test mode to compression (Settings>Sign Convention>Push +).  This setting is specific to 
the test template being used and can be saved to a template. 

 

 
 

Vertical Configuration 

1. Install the desired load cell (see Appendix B) to the Motor Bracket B of the UniVert. 
 

2. Attach the compression platen directly to the measuring end of the load cell. Choose an 
M5 or M3 platen depending on the load cell. 

 
Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
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3. Attach the M5 Compression Base Riser – Tall to the baseplate with an M5x16 SHCS 
using a 4mm hex key. Use the mounting hole furthest away from the power switch. This 
will be easier to do when the UniVert is lying in the Horizontal configuration. 
 

 

 

4. A position calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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Horizontal Configuration 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

In addition, the test sample will need to be supported by a supplementary riser (not included with 
the UniVert) to use the compression test setup in the horizontal configuration. 

 

1. Install the compression platen to the Tension Load Cell Bracket  
a. For an M5 threaded load cell, use the stainless steel M5 platen, M5 Tension 

Load Cell bracket, M5x12 SHCS, 4mm hex key and M5 Locking Disc.  
b. For an M3 threaded load cell, use the plastic M3 platen, M3 Tension Load Cell 

Bracket, M3x12 SHCS, 2.5mm hex key, and M3 Locking Disc. 
 

   
 

2. Install the load cell assembly (see Appendix B) to the fixed end of the UniVert with an 
M5x16 SHCS and 4mm hex key. Use the mounting hole closest to the power switch.  
Note that for the horizontal configuration, an additional locking disc should be added 
between load cell and thumbnut. 

 

  
 
 

  
 
 
 

 



UniVert User Manual 

93 

 

3. Install the Tension Load Cell Bracket to the load cell and affix it with the corresponding 
locking disc. The size of both these fixtures (M5 or M3) will depend on the load cell 
selected. 
 

  

 

4. Attach the M5 Compression Base Riser – Short to the Horizontal Bracket (No Load Cell) 
with an M5x12 SHCS 

 

 

5. Attach the assembly from the previous step to the Motor Bracket B with 2 x M5x12 SHCS 
 

 

 

 

6. A position calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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3-Point Bend Test Setup 

1. Set the test mode to compression (Settings>Sign Convention>Push +) 
2. Install the desired load cell for vertical configuration (see Appendix B) 
3. Attach a locking disc to the measuring end of the load cell. 

 

 

 

4. Assemble the 3-Point Bending Block and sliders: 

• Attach M2x6 fasteners on the sides of the sliders and bending blocks 

• Place 4-40 - 5/16” fasteners through the hole and the square nuts. Place the 
square nuts through the groove of the bottom block. 

• Use the large O-Rings and small O-Rings as illustrated below to hold the 3-point 
bending dowels in place (Note: Choose a dowel size appropriate for the test 
being performed. Small and Large dowels are provided with the 3-Point Bend 
package). 
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5. Screw the bending block onto the measuring end of the load cell and tighten it in the 
correct position using the locking disc. 

 

 

 
Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
 

6. Attach and align the 3-Point bend rail onto the baseplate with 2x M5x25 SHCS. This may 
be easier to do with the UniVert in horizontal configuration and tilted back. 
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7. Secure both sliders on the rail in the desired position by tightening the fasteners with a 
3/32” hex key. 

 

 

 

8. A Custom Position Calibration is required after changing fixtures (see the System 
Calibration and Advanced Tools section) Use the calipers to measure between the 
bottom of the top block and the top surface of the bottom block. This will prevent negative 
displacement readings. 
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Appendix E: Camera Setup 

Webcam 

The webcam included with the UniVert system is used for recording images at up to 5Hz.  The 
UniVert will function with or without the camera plugged in. To setup the camera, follow these 
steps: 

1. Before starting the UniVert software, plug the webcam into a USB port. 
2. Thread the tripod into the mounting hole on the bottom of the camera. 

 

  

 
3. Set the camera in the desired recording position using the flexible tripod. 

 

 

 

4. Refer to the System Hardware Settings section for additional camera settings.  
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Scientific Camera  

The scientific camera, an optional add-on to the UniVert system, is used for recording images at 
up to 15Hz and is compatible with the image tracking feature in the UniVert software. First, set up 
the camera positioning system. The components and tools required are: 

• Rail 

• 2 x M6x6 SHCS 

• Rail Carrier 

• Mounting Post 

• Post Holder 

• Post Collar 

• 5mm hex key 
 

 
 

1. Place the UniVert in the horizontal configuration. 
 

2. Install the camera rail with 2 x M6x6 SHCS using a 5mm hex key, in the desired location 
along UniVert tower. 
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3. Thread the Post Holder to the Rail Carrier. 

 

 

4. Slide the Rail Carrier onto the Rail and tighten the thumbnut at the back securely. 
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5. Insert the Mounting Post in the Post holder. Ensure the M6 threaded hole is facing 
outward. 

 

6. Attach the Post Collar to the Mounting Post. This is to ensure the post remains at the 
same height when adjusting the rotation with the Post Holder thumbnut. 
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Next attach the camera assembly to the positioning system. The components and tools required 
are: 

• Camera  

• Camera Bracket 

• Lens 

• USB 3.0 cable 

• M3x6 SHCS 

• 2.5mm hex key 

• M6x6 SHCS 

• 5mm hex key 

• Lighting gooseneck and power supply 

• Only for Camera Bracket shown below: 
o Mounting Plate 
o 4 x M2x6 SHCS 
o 1.5mm hex key 
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1. Remove the lens caps from both the camera and lens, and gently thread the lens onto 
the camera.  
 

2. Attach the camera to the Camera Bracket: 
a. If the camera bracket provided matches the left one shown below, continue to 

step 3. 
b. If the camera bracket provided matches the right one shown below, skip to step 

5. 
 

 

 
3. Attach the Camera to the Mounting plate first with 2x M3x6: 

 
a. For use in the Vertical configuration, attach the camera as follows: 

 

 

b. For use in the Horizontal configuration, attach the camera as follows: 
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4. Attach the Camera Bracket onto the camera assembly with 4 x M2x6 SHCS using a 
1.5mm hex key. Continue to Step 6 to mount this assembly to the Camera Mounting 
Post. 

 

 

 
5. Attach your bracket directly to the camera with 2x M3x6 SHCS: 

 
a. For use in the Vertical configuration, attach the camera as follows: 

 

 

 
b. For use in the Horizontal configuration, attach the camera as follows: 
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6. Attach the Camera Bracket to the Mounting Post with M6x6 SHCS using a 5mm hex key. 
Both style of brackets mount to the Mounting Post in the same manner.  
 

  

 
7. Prepare the components for the lighting gooseneck: 

a. 2x goosenecks 
b. 1x base 
c. 1x 5V power supply 
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8. To set up the lighting gooseneck: 
a. Attach the lights to the base. Ensure the keyway matches and they are well 

seated. Fasten them in place by tightening the locking nuts. 
 

 

b. Plug in the provided 5V power supply to the base 
 

 

c. Turn the lights on and adjust the brightness with the slider on the base 
d. Position the goosenecks towards the specimen when ready for testing 
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9. Attach the USB cable to the Camera, securing the USB locking screws, and plug the 
other end into a USB 3.0 (or higher) port on the PC. These are the typically labeled SS 
and/or have a blue plastic tab on the connector. 
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Lens Adjustments: 
 

1. The image brightness can be adjusted using the Iris Ring on the lens. It is recommended 
to leave the Iris Ring fully open and control image brightness with the Hardware Settings 
in the software (see the Reviewing Test Results section). 
 

2. Obtain desired magnification level by manually adjusting the W – T ring on the lens. 
 

3. Bring the image to optimum focus by manually adjusting the F – N ring on the lens. 
 

4. Use the set screws on each of the lens rings to lock them at the desired settings. 
 

 

 

  

Iris ring W – T ring F – N ring 
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Appendix F: Media Bath Setup 

The media bath allows specimens to remain submerged in a temperature-controlled fluid. 

Vertical Media Bath 

The components and tools required to set up the vertical media bath are: 

• Media chamber with attached heating plate 

• Fluid chamber valve and spout 

• PVC tubing (for draining chamber)  

• Syringe 

• 200mm mounting standoff 

• Standoff collar 

• Heater cable 

• Temperature probe (mounting clip is attached to media chamber) 

• M5x20 SHCS (1 + extra) 

• Media chamber O-rings (extra) 

• M3x6 FHCS (extra) 

• M5x20 Set screw (1 + extra) 

• Long M5 coupling nut 

• Long M5-M3 coupling nut 
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1. Fasten the compression platen to the main body using the provided M5x20 SHCS and a 
4mm hex key. 

 

2. Place the white collar over the compression platen, but do not tighten it yet. 
 

 

Load Cell Warning: 

Load cells cannot be submerged. Take care not to accidentally damage your load cell when 
preparing a sample or conducting a test. 
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3. Ensure that the O-ring in the media chamber is snug and not broken (if it damaged, it can 
be removed and replaced with another of the provided O-rings). 
 

           

 

4. Tighten the M6 SHCS in the white collar using a 5mm hex key to fasten the media 
chamber at the desired height. 
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5. For compression testing, attach the desired compression standoff to the protruding set 
screw in the 200mm standoff. 
 

 

a. Attach the desired load cell to the coupling nut provided. The coupling nut used 
will depend on the size of the threads (M5 or M3) on the given load cell, as well 
as the testing protocol (e.g., magnitude of displacement). The image below 
depicts a long coupling nut being used. 
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b. Attach the load cell assembly from the previous step to the Motor Bracket B on 
the UniVert with M5x12 SHCS and jog the moving end near its upper limit. This 
will allow for more room when installing the bath to the baseplate. Attach the 
appropriate compression platen (steel or plastic). 
 

 

 

6. For tension tests, place an M5 locking disc and a stainless steel grip on the 200mm 
mounting standoff. Tighten the locking disc so that the grip faces the proper orientation. 
The media chamber may need to be adjusted to properly mount and secure the testing 
sample. 
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a. Attach the desired load cell to the coupling nut provided. The coupling nut used 
will depend on the size of the threads (M5 or M3) on the given load cell, as well 
as the testing protocol (e.g., magnitude of displacement). The image below 
depicts a long coupling nut being used. 

 

 

b. Attach the load cell assembly from the previous step to the Motor Bracket B on 
the UniVert with M5x12 SHCS and jog the moving end near its upper limit. This 
will allow for more room when installing the bath to the baseplate. Attach the 
appropriate locking disc (M3 or M5) and the corresponding grip. Tighten the 
locking disc so that both grips are aligned. 
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7. Attach all connections for heater and temperature sensor 

 

   
  

Properly sealing the media chamber: 

Ensure that the handle on the plug is facing the back of the Univert system. This is the closed 
orientation. Attach the PVC tubing to allow for easier draining of the media chamber once 
testing is completed 
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8. Remove the D-clip on the media bath using a 2.5mm hex key and slide the temperature 
probe into the clip. Fasten the clip once again into the wall of the media bath. 
 

 

 
 

9. To activate the fluid chamber heater, turn on the main power switch of the UniVert 
followed by the heater switch (if present on your device – see below). At this point, the 
heater will warm the media to the last used temperature set point. The temperature set 
point can be changed by selecting Hardware from the Settings menu. If the plate does 
not feel warm after a few minutes, ensure the heater plate cable is plugged in. 
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a. If your UniVert has 2 switches on the front panel, the second switch on the left 
(below the orange LED indicator light) is used to toggle the heater on/off if the 
cable is plugged in.  

 

 

 

b. If your UniVert only has 1 switch on the front panel (i.e., the main power switch), 
the heater will automatically turn on with the main power if it is plugged in. If you 
do not want the heater plate to be on during your test, leave the heater plate 
unplugged from the main device. 

 
10. Typically, the heater will take 30 to 60 minutes to warm a full fluid chamber from room 

temperature to 37°C and will take up to 90 minutes to stabilize at this temperature.  Using 
pre-heated media will help reduce the time needed to reach temperature. 

 
11. When Show Temperature Warnings is enabled and the Current Temperature is not at the 

Temperature Set Point (plus or minus the specified tolerance) - a red indicator button will 
be displayed next to the Current Temperature live output and a warning dialogue will 
appear when you execute the test. 

 

 

 

12. Once your test is complete, use the supplied syringe to remove the media from the 
chamber. Ensure the bath is completely empty before removing the back plate from the 
polycarbonate chamber. 
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Horizontal Media Bath 

The components and tools required to set up the horizontal media bath are: 

• Plastic Fluid Dish 

• Heater Plate 

• Heater Pivot Wings with sleeve bearings 

• 4x M4x16 SHCS 

• Shoulder screws 

• 3mm hex key 

• Temperature probe 

• Heater cable 

• Extra M5 or M3 Locking Discs 
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1. Attach the Heater Pivot Wings to the Heater plate with 4 x M4x16 SHCS using a 3mm 
hex key. Ensure the Heater Pivot Wings are facing in the opposite direction to the 
electrical connector (as illustrated below). 

 

 

 

 

2. Mount the Heater Plate and Heater Pivot Wings assembly to the UniVert system with the 
supplied shoulder screws and 3mm hex key. This will be easier to do with the UniVert in 
the vertical configuration. 
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3. Place the UniVert back in its horizontal configuration. Be careful when doing so as the 
heater plate will swing freely. 
 

4. Attach the additional locking disc between the desired load cell and corresponding 
coupling. 
 

  
 

5. Attach the desired fixtures to the load cell in the Horizontal Configuration (see Appendix 
D for more details). Tilt the UniVert back as this will allow for more room when fastening 
the fixtures. 
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6. Place the fluid dish on the Heater Plate and attach all the connections for the heater and 
temperature probe. 
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7. Secure the temperature probe into the corner of the fluid dish 
 

 

 

8. To activate the fluid chamber heater, turn on the main power switch of the UniVert 
followed by the heater switch (if present on your device – see below). At this point, the 
heater will warm the media to the last used temperature set point. The temperature set 
point can be changed by selecting Hardware from the Settings menu. If the plate does 
not feel warm after a few minutes, ensure the heater plate cable is plugged in. 
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a. If your UniVert has 2 switches on the front panel, the second switch on the left 
(below the orange LED indicator light) is used to toggle the heater on/off if the 
cable is plugged in.  

 

 

 

b. If your UniVert only has 1 switch on the front panel (i.e., the main power switch), 
the heater will automatically turn on with the main power if it is plugged in. If you 
do not want the heater plate to be on during your test, leave the heater plate 
unplugged from the main device. 

 
9. Typically, the heater will take 30 to 60 minutes to warm a full fluid chamber from room 

temperature to 37°C and will take up to 90 minutes to stabilize at this temperature.  Using 
pre-heated media will help to reduce this time needed to reach temperature. 
 

10. When Show Temperature Warnings is enabled and the Current Temperature is not at the 
Temperature Set Point (plus or minus the specified tolerance), a red indicator button will 
be displayed next to the Current Temperature live output and a warning dialogue will 
appear when you execute the test. 
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Appendix G: Grip Modifications 

The grips used for tension testing come in three different gripping strengths to suit different 
materials and tests. Replacement springs of varying stiffness are provided with the UniVert and 
these may be switched at any time using the jig provided. The light, medium and heavy springs 
will provide 10N, 20N, and 40N of gripping force, respectively.  

Changing Grip Springs 

Current Generation Grips 

1. Gather the required tools: 

• Grip 

• Desired spring 

• 3/32” hex key 

• 3mm hex key 

• Flat heat screwdriver 

• Safety glasses (recommended) 
 

2. Remove the M4 locking screw with the 3mm hex key 
 

 

3. Push down on the front of the grip and lock the spring in back notch using the flat head 
screwdriver 

 

Back 
Notch 
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4. Remove the dowel screws on either side with the 3/32” hex key, and remove the top 
piece of the grip 

 

 

5. Gently push down on the top spring arm to release it from the back notch 
 

 

6. Tilt the grip to the side to remove the dowel and spring 
 

7. Position the desired spring in the center of the grip and place the dowel back in place 
 

 

8. Push the spring arm down and lock it into the back notch 
 

9. Place the top piece of the grip over top and use the 3/32” hex key to fasten the dowel 
screws on either side 

 
 

10. Push down on the top of the grip to release of the spring arm from the back notch. Use a 
flat head screwdriver if necessary 
 

11. Use the 3mm hex key to place the M4 locking screw back in place 
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Previous Generation Grips 

1. Gather the required tools: 

• Grip jig 

• Screwdriver 

• Grip 

• Safety glasses (recommended) 
 

 

2. To remove the current spring, press both halves of the grip and place it inside the 
provided jig to keep the grip slightly open. 
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3. Use a screwdriver to push the dowel out of the grip. 
 

 

 

4. Carefully take the grip halves and spring out of the jig. It may be easier to use two hands 
for this step. Use one hand to squeeze the grip and the other to palm over the assembly 
to contain all the parts as it is removed from the jig. 
 

System Alert 

A fully installed spring experiences a high amount of stored energy. When removing the 
grip and spring from the jig, be sure to maintain pressure on both halves of the grip. 
Safety glasses are recommended when changing grip springs. 

 

5. Remove the dowel from inside the jig 
6. Place the desired spring into the groove in the top half of the grip. 
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7. Align the clamping face of the bottom half of the grip to the top and carefully press it 
down to compress the spring. 

 

   

 

8. Place the grip and new spring into the jig. Again, using two hands may make this step 
easier. Use one hand to maintain pressure on the spring, and the other to palm over the 
assembly to keep all components together. 
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9. Press the dowel into the grip 

  

 
10. Remove the grip from the jig by pinching the grip while pulling up 

 

 

Changing Jaw Coverings 

The current generation grips have jaw coverings available in a soft silicone or hard plastic with 
sandpaper.  The coverings are easily interchangeable by sliding the coverings on and off the grip 
jaws while the grip is open.  These coverings are optional and are best used if they provide a 
stronger grip on the test sample.   

 

UniVert Tip: High Force Grips 

Tighten the M4 locking screw on the high force grips (stainless steel) with a 2.5mm hex key to 
increase clamping force if the heavy springs are not enough. Do not use excessive force 
when tightening the screw. Overtightening could strip the screw hex head or damage the 
specimen. 
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Appendix H: Low Force Load Cells 

Low force load cells are an optional add-on to the UniVert system. They are available in 0.5N, 1N, 
2.5N, and 4.5N capacities. These load cells have M3 female threads and will require a special set 
of fixtures. Components and tools required to use a low force load cell include: 

• Low force grips (M3 male thread and M5 female thread) 

• Light springs 

• Medium springs (assembled in grips) 

• Heavy springs 

• Low force compression platen (M3 male thread) 

• Plastic M3 Tension Load Cell Bracket 

• M5 to M3 stand off (long) 

• M5 to M3 stand off (short) 

• M3 Coupling nut 

• 2x M3x8 SHCS 

• 2.5mm hex key 
 

 

 

 

 

 

 

 

 

 

 

Load Cell Overload Warning: 

When using a 0.5N or 1N load cell, the zero-position calibration spring cannot be used. The 
procedure causes the system to exert 1N of force on the spring to determine its position. This 
action risks overloading load cells of this sensitivity. Instead, use calipers or a ruler to record 
the displacement between the compression platen and riser when conducting this calibration, 
and input this information under Tools → Custom Position Calibration. 
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All test fixtures should be mounted to the measuring end of the load cells. The active measuring 
end of the low force load cells are shown below.  

      

 

Due to their low capacity and sensitivity, be careful when handling these load cells. Only 
handle the load cell by their sides and only use the low force fixtures to avoid overloading the 
load cells. 

Tension Test Setup 

The low force grips are required to be used with the low force load cells. Replacement springs of 
varying stiffness are provided with the low force grips. The light, medium and heavy springs will 
provide 12N, 24N, and 60N of gripping force, respectively. 

 

1. Set the test mode to Tension (Settings>Test Mode>Tension). This setting is specific to 
the test template being used and can be saved to a template. 

 

 
  

Active End 

(Marked with F or  the 
side along black logo) 
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2. Attach the M5 to M3 stand off to the non-measuring end of the low force load cell. 

• For vertical configuration, use the longer stand off 

• For horizontal configuration, use the shorter stand off 
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Vertical Configuration 

1. Attach the load cell assembly to the Motor Bracket B with an M5x12 SHCS using a 4mm 
hex key 

 

 

 

2. Ensure the measuring end of the load cell is exposed and attach the M3 (male thread) 
grip directly to the measuring end of the load cell.  

 

 

 
Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
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3. Attach the M5 stand off to the baseplate of the UniVert with an M5x16 SHCS using 4mm 
hex key. This may be easier to do with the UniVert in the horizontal configuration. 
 

4. Attach the M5 locking disc and M5 grip to the M5 stand off. 
 

 

 

5. Align the grips to be parallel by loosening the M5 screw/locking disc and rotating the load 
cell assembly/grip. Only handle the load cell assembly by the coupling or the sides of the 
loadcell. Twisting the grip while it is attached to the load cell can result in overloading. 

 

 

 

6. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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UniVert Tip: Mounting Low Force Load Cells to the Fixed End - Tension 

At velocities 3mm/s and slower, the UniVert uses smoother displacement commands to 
minimize vibrations induced from the actuator and fixtures. However, these commands cannot 
be used for velocities 3mm/s and faster since the desired velocities would be unachievable. 
The induced vibrations are generally negligible; however, due to the high sensitivity of low 
force load cells some of these vibrations can still be noticeable and may impact your test 
results. 
 
If any test protocol lines in your template exceed 3mm/s or your force readings are not smooth, 
we suggest mounting the low force load cell assembly to the fixed end of the UniVert for 
Vertical configurations.  
 
To set up your Low Force Load Cell on the fixed end, simply take your load cell assembly and 
mount it to the base place with an M5x16 SHCS and 4mm hex key. Attach the remaining grip 
assembly to the moving end with an M5x12 SHCS and 4mm hex key. 
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Horizontal Configuration 

 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

1. Attach the grip to the M3 coupling nut and affix it to the Plastic M3 Tension Load Cell 
Bracket with an M3x8 SHCS using 2.5mm hex key.  

 

  

 

2. Attach the load cell to the above assembly with an M3x8 SHCS using a 2.5mm hex key 
 

Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 

3. Attach the load cell assembly to the baseplate with an M5x16 SHCS using a 4mm hex 
key 
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4. Attach a M5 locking disc to the M5 stand off and attach the M5 low force grip to this 
assembly 
 

 

5. Attach the assembly from the previous step to the Horizontal Bracket (No Load Cell) with 
an M5x12 SHCS and 4mm hex key 

6. Mount the assembly from the previous step to Motor Bracket B with 2 M5x12 SHCS and 
a 4mm hex key. 

 

 

 

7. Align the grips to be parallel: 

• For the fixed end (i.e. side with load cell), loosen the M5 screw in the baseplate 
to rotate the load cell assembly. 

• For the moving end, loosen the M5 locking disc and rotate the grip. 
 

8. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details 
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Changing Grip Springs 

The grips come with three different gripping strengths to suit different materials and tests. The 
light, medium and heavy springs will provide 12N, 24N, and 60N of gripping force, respectively.  

 

To change a grip spring follow these steps: 

1. Gather the required tools: 

• 2.5 mm hex key 

• Grip 

• Spring 

• Calibration Plate 

• Safety glasses (recommended) 

• Small mallet and small screwdriver (optional) 
 

 

 

2. To remove the current spring, hold the grip with the pivot hole and dowel over top the M5 
hole of the Compression Plate. 
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3. Use the 2.5mm hex key to push the dowel out. Alternatively, a small mallet and/or a small 
screwdriver can be used instead or to assist in this step. 

 

  

 

4. Carefully separate the grip halves and remove spring out. The hex key or screwdriver will 
have likely taken the place of the dowel in the pivot hold of the grip. Carefully hold the 
grip with one hand while removing the hex key or screwdriver. 

 

 

 

System Alert 

A fully installed spring experiences a high amount of stored energy.   When removing 
the spring from the grip, be sure to maintain pressure on both halves of the grip. Safety 
glasses are recommended when changing grip springs. 

 

5. Remove the dowel from inside the Compression Platen. 
 

6. Place the desired spring into the cutout of the bottom half of the grip. 
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7. Align the clamping face of the top half of the grip to the bottom and carefully press it 
down to compress the spring.  

 

 

 

8. Ensure the pivot hole of the grip halves are aligned and press the dowel into the grip. If 
needed, gently tap the dowel against the surface of the table or with a small mallet while 
holding the grip securely. 
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Compression Test Setup 

The low force compression platen is required to be used with the low force load cells. Note the 
test sample will need to be supported by a supplementary riser (not included with the UniVert) to 
use the compression test setup in the horizontal configuration. 

 

1. Set the test mode to compression (Settings>Test Mode>Compression).  This setting is 
specific to the test template being used and can be saved to a template. 

 

 
 
 

1. Attach the M5 to M3 stand off to the non-measuring end of the low force load cell. 

• For vertical configuration, use the longer stand off 

• For horizontal configuration, use the shorter stand off 
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Vertical Configuration 

1. Attach the load cell assembly to the Motor Bracket B with an M5x12 SHCS using a 4mm 
hex key 

 

 

 

2. Ensure the measuring end of the load cell is exposed and attach the Low Force 
compression platen directly to the load cell 

 

 

Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 
 

3. Attach the M5 Compression Base Riser – Tall to the baseplate of the UniVert with an 
M5x16 SHCS using 4mm hex key. This may be easier to do with the UniVert in horizontal 
configuration. 

 

4. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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UniVert Tip: Mounting Low Force Load Cells to the Fixed End - Compression 

At velocities 3mm/s and slower, the UniVert uses smoother displacement commands to 
minimize vibrations induced from the actuator and fixtures. However, these commands cannot 
be used for velocities 3mm/s and faster since the desired velocities would be unachievable. 
The induced vibrations are generally negligible; however, due to the high sensitivity of low 
force load cells some of these vibrations can still be noticeable and may impact your test 
results. 
 
If any test protocol lines in your template exceed 3mm/s or your force readings are not smooth, 
we suggest mounting the low force load cell assembly to the fixed end of the UniVert for 
Vertical configurations.  
 
Important Note: In compression test mode, the weight of your sample should not exceed the 
capacity of your load cell since it will be resting on the load cell throughout the entire test. 
 
To set up your Low Force Load Cell on the fixed end, simply take your load cell assembly and 
mount it to the base place with an M5x16 SHCS and 4mm hex key. Attach the remaining 
compression platen to the moving end with and M5x12 SHCS and 4mm hex key. 
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Horizontal Configuration 

 

Note the steps below outline the horizontal configuration that is required for the Horizontal Media 
Bath. If you do not have or want to use the Horizontal Media Bath for your test, you may use the 

vertical configuration set up with the UniVert tilted 90 on its side to use the device horizontally if 
this is more convenient for your test set up.   

 

In addition, the test sample will need to be supported by a supplementary riser (not included with 
the UniVert) to use the compression test setup in the horizontal configuration. 

 

1. Attach the Low Force Compression Platen to the M3 coupling nut and affix it to the 
Plastic M3 Tension Load Cell Bracket with an M3x8 SHCS and 2.5mm hex key 

 

 

2. Attach the load cell to the above assembly with an M3x8 SHCS and 2.5mm hex key 
 

Finger tighten all components.  Beware of exerting excessive off-axis and torquing forces 
to avoid damage to the load cell. 

3. Attach the load cell assembly to the baseplate with an M5x16 SHCS using a 4mm hex 
key 
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4. Attach the M5 Compression Base Riser – Short to the M5 stand off 
5. Attach the above assembly to the Horizontal Bracket (No Load Cell) with an M5x12 

SHCS and 4 mm hex key 
 

6. Mount the above assembly to the Motor Bracket B with 2 x M5x12 SHCS using a 4mm 
hex key. 

 

 

 

7. A Zero Position Calibration is required after changing grips or platens.  See the System 
Calibration and Advanced Tools section of this manual for more details. 
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Appendix I: BioRake Brackets 

 

BioRake and BioRake Brackets are an optional add-on to the UniVert and can only be used with 
load cells 20N or lower (M3 thread). The tools and components required to use the BioRakes with 
the UniVert include: 
 

• BioRakes 

• BioRake Bracket - Load cell 

• BioRake Bracket - No Load cell 

• Sample Mounting Blocks and Backing Material 
 

 
 

1. Set up the desired load cell as per Appendix B for standard load cells or Appendix H for 
Low Force load cells. 
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2. Attach the BioRake Bracket – Load Cell to the load cell: 
a. For standard load cells, use a locking disc to fasten the bracket. 

 

 

b. For low force load cells, use a M3x8 SHCS and 2.5mm hex key to fasten the 
bracket. 

 

3. Attach the BioRake Bracket – No Load Cell to the Horizontal Bracket – No Load Cell with 
a M5x12 SHCS and 4mm hex key. 

 

 

4. Open the software and select Collect New. 
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5. Set the test mode to Tension (Settings>Test Mode>Tension). This setting is specific to 
the test template being used and can be saved to a template. 

 

 
 

6. Place the BioRakes on the brackets and use the jog command to bring the BioRake tips 
close together. 

 

 

7. Loosen and re-tighten the M5 fasteners or M3 locking disc to align the BioRakes such 
that they are horizontally aligned (i.e. parallel when looking from above) and vertically 
aligned (i.e. parallel when looking from the side)   
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8. To set the zero position: 
a. Set one of the BioRakes slightly offset from the other 
b. Jog the BioRakes closer together until the rakes are just intertwined 

 

 

c. Open the Custom Position Calibration in the Tools menu 
d. Set this position as 0 mm in the Custom Position Calibration menu 

 

 

 

9. The BioRakes are now ready to have a sample mounted.  To do this you will need the 
sample mounting block(s) and the backing material.   

a. When mounting a sample without the horizontal media bath, both mounting 
blocks will need to be stacked on top of one another with the backing material on 
top. The total height should be 58mm. 
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b. When mounting a sample with the horizontal media bath, only the shorter of the 
two blocks will be required. Place the backing material on top. It should be 
oriented in the shortest height (23mm tall). 
 

 

 
10. Your sample can now be placed on top of the backing material. 
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11. Tilt the UniVert and align the sample mounting platform under the BioRake tines. 
 

 
 
 
 
 
 
 
 

12. Now set the UniVert back down with the rakes over your sample 
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13. Push down on the tines on both sides to puncture and secure the specimen in place. 
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14. Tilt the UniVert back again to remove the sample mounting block and backing material. 
 

 
 

15. Set the UniVert back down and the test can now be started. 
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